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2.1

Overview

TD Guide to Using Bridgemates with Scorers

This document covers the use of Bridgemates with the Scoring programs -

IndScorer
PairsScorer
TeamsScorer

SwissPairsScorer
SwissTeamsScorer

Individual Scorer
Duplicate Bridge Scorer
Teams Scorer

Swiss Pairs Scorer
Swiss Teams Scorer

These are fully described in User Guide To Scorers [Ref 1].

2.2 Abbreviations
Abbreviation | Description
BCS Bridgemate Control Software Program
Scorer Refers to any of the Scoring Programs
NBL Northern Bridge League

2.3 Referenced Documents
Ref | Date Title Author
[1] | 19-Jun-2010 Scorers Reference Manual Jeff Smith
[2] | 03-Sept-2008 | Guide to Brighton 2008 Swiss Scorers Jeff Smith
[3] | 15-Sept-2009 | Swiss Pairs Scorer using Bridgemates lan Ross
[4] | 10-Nov-2008 | Swiss Teams Scorer using Bridgemates John Wilson
[5] | 17-Mar-2010 Running a Pairs Event with PairsScorer Jeff Smith
[6] | 12-Jun-2010 Running a Teams-of-4 Event with TeamsScorer Jeff Smith
[7] | 12-Jun-2010 Running NBL Teamof8 Matches using Bridgemates | Jeff Smith
[8] | 12-Sep-2009 Running an Individual Event with IndScorer Jeff Smith
[9]
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3.1 Hardware Components

PC
. 127
- — =
—
Bridgemate Pro Control Scoring Program

Software(BCSK_

-

The above diagram shows the key hardware components. The Bridgemates on the tables
communicate with the Server (small white box) using wireless communications. The Server directs the
movement to the Bridgemates and gathers all the scores independently of the PC that houses two
programs. The PC and the Server are connected using a cable that is attached to the computer's
Serial or USB port. If the PC, BCS or Scorer fail, the Server continues to operate independently
reading in scores from the Bridgemates.

3.2 Bridgemate Scoring System

At the start, the director sets the movement (e.g. 8% table skip with missing Pair No 9) and the Scorer,
puts this into a shared Database. When Scorer launches Bridgemate Control Software (BCS), the
movement data (i.e. boards, pair numbers, tables etc) is passed by BCS on to the Bridgemate Server
which then sends the data out to the Bridgemates. The Bridgemates accumulate the player results
data and return it to the Database via a holding area in the Bridgemate Server. This may be accessed
by the Scorer to calculate the results. Two separate programs run on the PC when a Bridgemate
session is in progress:

* BCS is the program supplied by the developers of the Bridgemate scoring units. It reads data from
the Bridgemates via the Bridgemate Server unit, and holds the information in a Database on the PC.

» The Scoring Program sends movement data to, and receives names and results data from, the
Database.

The Database is an Access database holding only the most basic of data, specifically:
« the player numbers entered at the start of the session; and
* the contract, declarer and tricks won for each board and pair number combination.

The Scoring Program extracts the results from the database, and is responsible for calculating scores,
accumulating results, factoring where necessary, printing results and web site reports, and
determining masterpoints. BCS is responsible for continuously extracting data from the Bridgemate
units via the Bridgemate Server. Do not close this program during a session. There is no need to
access this program at all through the session, although it contains some useful functions for
assessing the status of a session and some recovery options.
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When the players turn on their Bridgemate, it reads the server and extracts the movement data for that
table. (Note that even with multiple bridge sections in the room, just one Database may be used.).
Throughout the session, as data is entered into the Bridgemates, it is sent immediately to the
Bridgemate server. Every second, BCS reads the Bridgemate server, and any new data is put into the
Database. The Scorer polls the Database for updates or reads all the results on demand.

Thus, the results data exists in several places.

¢ |n the Bridgemate units. It can be extracted (as a last resort) by connecting the Bridgemate
unit to the PC via the special cable, and running the option Read Bridgemate Locally from with
in the Bridgemate Pro Control software.

¢ In the Bridgemate server. It remains there for as long as the Server remains powered and/or
until another session is pushed into it.

¢ |nthe Database on the PC.
e Inthe Scorer after it is imported from the Database.

For recovery purposes, BCS may synchronise the server and the Database. You can either push the
data that is held in the Database to the Server (you would do this if the Server lost power and hence

its memory) or you can pull data from the Server into the Database (you would do this if the PC, BCS
or Scorer has crashed).

3.3 Installation

3.3.1 Hardware Requirements

Any IBM compatible computer running Windows 95 upwards. The minimum computer screen area
display is 800 x 600 pixels. The screen setting can be located by rightclicking an empty area on the
screen, then choose Properties/Settings (or via Control Panel, Display and Settings).

Processor Pentium 11 300 MHz or higher
Memory 64MB or higher

The PC should have a Serial port. If your PC does not have a Serial port, you will need a USB —
Serial converter (available from Bridgemate Pro supplier or other computer equipment outlets) — see
Bridgemate Pro manual p8 for details. You should also ensure a Laptop will not hibernate or go into
standby after a certain time. This can be done using the Power Options in Control Panel.

3.3.2 Installation of Bridgemate Firmware

To utilise Bridgemate scoring you must download the Bridgemate Pro Control Firmware from the Web
Site at http://www.bridgematescoring.com
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4.1 Server Setup
4.1.1 Servers
= Each Server can service up to 128 Bridgemates simultaneously.
= A Server has an uninterrupted range of ~100m, but this can be reduced severely if the signal
has to pass through walls or partitions.
= The Server MUST be connected to the mains when in use. Batteries are only for back-up in
an emergency (e.g. power failure).
= At the end of a Session, disconnect the mains supply and remove one battery from the Server
= The Server should be at located at least 12" from any electronic equipment (e.g. computer).
= The Server should be placed horizontally on a level surface.
= Do not place any object on or near the Server.
= Server connects to the PC via a Serial port. If your PC does not have a Serial port you will
need a USB — Serial Converter (ref Bridgemate Pro manual p8). When using a Converter,
ensure the Serial port has a port number between 1 and 6. If the assigned COM port is 7 or
higher, it will need to be corrected manually in Device Settings of Windows Control Panel.
4.1.2  Setting up Server
= Insert battery into the Server; red light will come on.
= Connect to mains and light will turn green.
= Connect Server to PC via the Serial port of the computer (or via USB — Serial Converter).
= Place Server in a suitable position (see para B1 above)
4.1.3 Check Communication & Set BCS Preferences

After the Server & the Bridgemates are all set up start BCS using BMPro.exe. Check that the
Bridgemate RF Server is connected — top left-hand panel.
Click on Tools > Options; the following screen appears: -

Options ﬁ

General lBridgemale] Lag file]

tode Bndgemate Pro server
" Club [single cormputer] [ Disable server detection

% Toumament [network] [D'oes not dizable server detection at startup)

Dizplay

v Show report when movement updated by external program

Results in Bridgemate Pro Contral are dizplaped using notation:

|L||:u.-’du:uwn trick s ﬂ

[Does not effect rezult setting on tab 'Bridgemate']

Show result matnx as:
{* Board / tahle
™ Table / board
" Board / declarer
(" Declarer / board

Cancel | ] |

On the General >View Tab, tick “Show report when movement updated by external program” > OK
On the Bridgemate Tab,set ‘Use Bridgemate Pro Settings specified by:’ Scoring Program.This way the
Bridgemate Preferences will be set by the scoring program.
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4.1.4  Setting the Channel

The Server must be on the same channel as the Bridgemates it is communicating with. To check or
alter the channel, select Server from the Menu Bar > Channel selection. The “Current channel”
function displays the current channel. To alter the channel, select the new channel and click Set then
Close.

4.2 Close BPC Control using File > Exit.

4.2.1 Bridgemates Section/Table

For a normal Single Section movement, the Section/Tables are numbered Al, A2, A3 on the
Bridgemates etc. For a MultiSection Event, further Sections are numbered B1, B2, B3 etc, C1, C2 ,C3
etc.

4.2.2 Bridgemates Switch On

Switch on the Bridgemates by pressing OK. The following message should appear on the screen: -

1.1.1.1 BRIDGEMATE PRO
1.1.1.2 V2.1laEN

(The 2" line indicates the firmware version and language)

4.2.3  Altering the Contrast

Press the + or — key repeatedly to adjust contrast (do not press and hold either the + or - key).

4.2.4  Setting the Bridgemate

While the BRIDGEMATE PRO message is on the screen insert the TD key (if message has
disappeared, press OK to awaken the Bridgemate). A message similar to that below will appear:-

GROUP: A +/-
TABLE: 1

Press +/- to alter the Group (Section) letter. If one Section then A; if more than one (max 26),
Sections must be consecutive (eg A, B, C); then OK

Cursor now flashes at Table No.

To alter the Table Number, press CANCEL to delete current number, enter the required Table
Number, and then press OK.

The following message now appears: -

CHANNEL: 0

If only using one Server, select 0; then OK. If using more than one Server, it is advisable to have each
Server on a different channel (8 available; numbered 0-7). To change channel, press CANCEL to
delete the current channel and then enter number (0-7) for required channel. Press OK; and the
message SETTINGS SAVED appears. After a few seconds the message shown in Al appears.
Remove the TD key.
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51 Create Database

Clears all previous results and sets the new movement details in the Database. If you have not
changed the movement (usually after recovering from a failure), when you are informed that
the Database already exists, you should reply ‘No’ so that the Database will not be overwritten.
(If an existing Database is overwritten, then it will first be saved in the Backups folder).

5.2 Set BS Options

Set the appropriate options in BCS. There is a default setting option for each Scorer.

5.3 Launch BS

Launch the BCS program with the movement details. There is an option to set the location of the BCS
program If Reset Server option is ticked, the Server clears any previous information and uploads the
tables in the movement which reinitialises all the Bridgemates. Check the BSC screen shows all the
tables have been ‘Added’ and showing Red Indicators. It is important to watch this process to see that
it adds tables, because if there is a communication problem, no tables will be added. Communication
problems may sometimes be resolvable by rebooting the PC.

54 Update Database

Change the movement in the Database once BCS is running. This is used in Swiss Scorers to update
the Assignments for each Round. It may also be used if there is a late movement change in the
Individual, Pairs or Teams Scorers.

5.5 Start Receiving

Poll the Database every 10 seconds looking for new results. The ongoing rankings may be viewed by
ticking the ‘AutoRank’ option. With large fields, the rolling rankings may be viewed in your default web
browser by ticking ‘AutoScroll’. Size of text can be increased or decreased by pressing Ctrl+ / Ctrl-.

5.6 Read All Results

Read all the results in the Database.

5.7 Restart

Reenable the Create Database button hence allowing a restart. This would most often be needed if
BCS has been inadvertently closed.
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6.1 Running a Bridgemate Session

Check your PC's power settings, including hibernation to ensure the PC cannot enter power-safe or
hibernation mode during a session — this can cause problem with the BCS that runs continuously.

For a Single Section event, the Section/Tables are numbered Al, A2, A3 etc. For a MultiSection
Event, further Sections are numbered B1, B2, B3 etc, C1, C2 ,C3 etc. To change the Bridgemate
section letter or table number , use the TD-key at start of session whilst the BridgeMate screen shows
BRIDGEMATE PRO V2... EN.

Insert TD-key to adjust the section letter and / or table number.

Press +/- to adjust the group letter and click “OK”.

Press Cancel to delete table number, enter the new table number and click “OK”. Remove TD-key.
(Ignore the “0” after the section letter unless you have more than one Club using BridgeMates)

Use Create Database to set the movement details in the Database. You will be warned if the file
already exists (since you don’'t want to overwrite it in a recovery situation.

Use Set Options with the default values or otherwise.

Check the Server is connected and turned on (green light for A/C power is on, orange light for
batteries) and that BCS isn’t already running.

Use Launch BS with ‘Reset Server’ ticked. BCS will reset the Server and pass the movement details
to the Server which initialises all the Bridgemates. If BCS was inadvertently closed by the user, then
untick Reset Server. Check the BCS screen shows all the tables have been ‘Added’ and showing Red
Indicators. You should watch the BCS screen to see that it adds tables, because no tables will be
added if there is a communication program. Communication problems may be able to be resolved by
rebooting the PC.

Distribute the Bridgemates to the appropriate tables, including the sit-out table if applicable, and
players can turn them on. Instruct the players to login by pressing OK on their Bridgemate which
should register on the BCS screen by the Indicator turning Green. When the session is complete, the
indicators will return to Red. After a welcome screen, they will be asked for the numbers (if the
relevant BCS option is set) for the players sitting in each position around the table. They can enter
either their Club Number or their EBU number. If they are uncertain, they can leave the entry blank or
enter zero — this will result in an “unknown name” in Scorer, which can be changed later within Scorer
itself. Be careful to distribute the right Bridgemates to the right section if there are two or more
sections. The Scorer and the BCS should both remain open throughout the session.

Use Start Receiving to poll for results from the Database. You may return to the another menu (eg to
change the names, print assignments etc ) and revert back to the Bridgemate Screen but you will
need to Start Receiving again

If the Scorer or BCS stop or you exit the event for any reason, then you can restart by reentering
Bridgemate Scoring, Create Database (Reply N if already created) and ‘Start BS without Reset
Server checked. The main screen listboxes shows the number of results received at each table and a
table of awaited scores. There are several commands on the Scorer Bridgemate menu for displaying
current scores and rankings. You can set the Continuous Display box to display the rankings every 10
seconds (if a new score has been received) and to scroll that display.

6.1.1 Update Database

This is used in Individual,Pairs & Teams competitions when BCS is running (and possibly play
started) for a late change to the movement (i.e. a late pair) or wrong movement set, or just possibly to
revert back to a specific round after a recovery partway through a competition. On the BCS screen, set
the Update From Round and click Update Database. This wiill erase all data (results and movement)
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previously received for that round and onwards in the Server. The movement is changed but the
results in the Database will be left intact.

If no-one has entered any scores, you can Update from Round 1. If this late change necessitates a
change to the Round 1 pairs and/or tables, but scores have already been entered for Round 1 (for
example, a late pair arrives and fills the sit-out table), you can either Update from Round 1 and get the
scores reentered or you can use the Recover squence (Sec 6.6) to synchronise the Server to the
Database results (ignoring possible mismatches due to the movement change). Those results can be
edited or deleted via Scorer later.

In Swiss competitions, each round is treated as a Session by the BMs and must be updated.
Consequently, the User must Update Database every round after the new Assignment. The Update
From Round value should default to the next round after the last Update. You can manually overwrite
the Update From Round value. Before an Update, the Scorer pops a message:

"Last Update was from Round x. Confirm you want to update the movement from Round y onwards"

BCS will probably pop up a message headed by "Report" showing the movement has been updated
by an external program. Click [close] if needed. (This occurrence will depend on the BPC
[tools][options]'General” in where "Show report when movement updated by external program" is
ticked.) . As each table is recognized by the Server the Bridgemate device will be reset with the new
movement information.

6.2 Recovery Procedure

The user should familiarise himself with the Recovery Procedure since it is needed whenever
the Server (and hence Bridgemates) needs to be synchronised with the BCS or the Scorer.

The most obvious cause is when the Server is incorrectly updated by the User or stops
working).

If the Server is accidentally unplugged, it will still continue to run on battery and may just be plugged
back in. If the Server has stopped working (lost power) or an Update from Round command has
specified the wrong round, then the Recover function may be used.
The BCS Session - Synchronize/Recover menu function synchronizes the server with the current
database. All existing Server data will be deleted and overwritten with the tables and scores contained
in the Database.

= Reconnect Server to power.

= BCS Control > Session > Synchronise/Recover > Recovery tab.

Click Recover Server:

Bridgemate® Pro Control

<2 By recovering the server all current data in the server will be erased and the server will be synchronized ko the session database. Scores in the session database will
‘-—':/ be stored in the server. &re vou sure vou wank to recover the server?

Yes

Click > Yes; another message appears: -

Bridgemate® Pro Control

“-?f) This will delete all data stored in the Bridgemate server, Are wou sure you want bo reset the server?

Click > Yes
Enter number shown > OK

Report appears regarding scores updates > close.
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Ensure BM Pro is retrieving data; If not, then on the BCS Menu Bar use Session > Update Movement
(status now changes to retrieving).

Bridgemates will still be red; press OK on bridgemates till they appear in green and you are back
where you were when computer closed down.

If a table has entered results when the computer was down they are lost during the recover server
process and will have to be re-entered. Check on the Scorer’s Bridgemate control screen for any
outstanding scores for the current round and advise any tables with missing scores to re-enter them
on the bridgemates.

6.3 Bridge Control Software Program Inadvertently Closed

If BCS is (inadvertently) closed during a session (perhaps an unexpected re-boot or power failure),
you must re-establish the connection between BCS and the Server/Bridgemates.

1 Use ‘Restart’ on the Bridgemate Screen to reenable Create Database button.

2 Click Create Database. In reply to the ‘movement already exists’ message, reply N.

3 Launch BS with Reset Server unticked. This should re-establish the interface with BCS.

4 Start Receiving data.

The system should be back and operating as before. Any results sent from the Bridgemates to the
Server while the Scorer was down should be delivered to the Scorer.

6.4 Scorer Inadvertently Closed

If the Scorer is (inadvertently) closed during a session, you must re-establish the interface with BCS.
Retrieve the Event that you were using before the problem occured.

Click ‘Bridge Scoring'.

Click Create Database. In reply to the ‘movement already exists’ message, reply N.

If BCS was also closed then Launch BS with Reset Server unticked.

Start Receiving data.

DD WNEF

The system should be back and operating as before. Any results sent from the Bridgemates to the
Server while the Scorer was down should be delivered to the Scorer.

6.5 Scorer Inadvertently Created Database

This can only occur when BCS is not running. If you inadvertently Create Database (maybe after a
crash), the Scorer clears the Database results and writes the new movement. Since all the Scorer
results are left intact, you should just launch BCS with Reset Server unticked (though obviously you
must not do a Read All Results command since that would overwrite the Scorer’s data).

6.6 BCS Launch Inadvertently with Reset Server

If you accidentally, leave Reset Server ticked, then the Server will pass the new movement data to the
BMs which will revert back to Round 1. As the data should be still secure in the Scorer, you can still
revert back to the last round in progress.

One method is the Recovery sequence to synchronise the Server data back with the the Database.
This is fully described in Sec 6.1.

An alternative is: BCS Session > Close Round. This allows you to mark previous round results as not
played and thus force BCS to continue from the specified round.

A further alternative is:

la Session > Edit Movement

1b Set this in Round Order

1c Setthe NS and EW Pairs to 0 for all the rounds for which a score has already been received.
2 Session > Update Movement > Update Now.

6.7 Bridgemates Showing Incorrect Round

This is usually caused by an Update from Round command incorrectly set to an earlier round
especially in Swiss events.
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The recommended solution is to do the Recover sequence as Sec 6.1. This will synchronise the
results to those in the Database which will mirror those in the Scorer.

Alternatively, you may force the Bridgemates to poll from the current round by using the BCS Close
Round or Edit Movement methods described in Sec 6.6
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7.1 On the Bridgemates

The preferred way to change/delete a score is at the Bridgemate terminal (with the TD key) as it will
be seen by the players and updates the Server, BPC and the Scorer. Wrong scores can be corrected
by the players at the table until such time EW has pressed OK and accepted the result. After this, the
TD can erase a result using the TD key, but only during the current round, or into the next round
before any new results have been entered. Although there is a TD key function to enter Assigned
scores, it is simplest to enter 0. This is recorded as Not Played and assigns a 50/50 score temporarily.
The real assigned/adjusted score will need to be input at a convenient time (usually the end) in the
normal way.

7.2 In BCS

You may change or delete results in the BCS result file and displayed in its result list. Right-click on
the appropriate result and select Edit score. A detailed screen will appear displaying all the score
data. You can now edit any of the fields the result: In the NS/EW box enter the Declarer, NS/EW,
Contract, Result and Lead. For the contract field, clubs = C, diamonds = D, hearts = H, Spades = S,
no trumps = NT, double = x, redouble =xx, pass = PASS. Enter the Contract & Result & other
corrections. To replace a score with an artificial assigned score, edit the Contract & Results boxes so
that they are blank and then enter the assigned score in the Remarks column as 60%-40% or
whatever. You must untick the Processed flag to ensure that the Scorer is updated. If a board result
is changed in BCS, the new result is not transferred to the Server/Bridgemates.

To delete a board result, right-click on that result and select Delete score. To delete Multiple scores
simultaneously, press and hold the Ctrl key and use the left mouse button to select the scores you
would like to delete; right-click > delete. Deleted scores will be deleted from the scoring program even
if the score has already been read and will also be deleted from the Server/Bridgemates.

7.3 In the Scorers
You can change/delete a result in the Scorer on the ‘Enter Scores’ screen.
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8.1 Accessing the TD Menu

Tournament directors can do several functions (not available to the players) using a special TD menu
It may only be activated when the Bridgemate is waiting for data entry and will not work if the device is
in the verification screen or is displaying an overview of previous results. You may need to press
Cancel on bridgemate to get to the BOARD/CONTR screen.

To access this menu:
Insert the TD-key when the Bridgemate shows BOARD / CONTR screen
A message “TD-MENU” appears on the screen
Press on the relevant option and “OK” when prompted to confirm.

To escape at any point, press CANCEL to return to the TD Menu screen.
To exit the menu, simply remove the TD-key.

Options are: -

1 Enter an arbitral score (Enter the board number, press OK then insert the TD-key)
View results

Erase result

Show group/table number and round data (round number,boards,pair numbers)
Show missing boards (boards during current round that have no scores)

Reset Bridgemate

QuUIThWN

8.1.1 Enter an Arbital Score

The cursor is positioned at CONTR. Enter the arbitral score for both pairs: NS: & EW.

You can choose between 40%, 50% and 60%. Press 4 or — to enter 40%, 5 or = to enter 50%, 6 or +
to enter 60%. It is not possible to enter a value other than these percentages. Press OK after you
have entered the percentage. Do this for both pairs. The screen will now return to the TD MENU.
Remove the TD key. The assigned arbitral score is now displayed at CONTR. Press OK to confirm
this, and confirm the verification screen. The Bridgemate has now saved an arbitral score for this
board and will feed this to the scoring program during read-out.

8.1.2 View Results

Enter a board number. The overview displays the pair number, direction of play, contract and result.
If the screen returns to the TD menu after the board number has been entered, no scores will be
registered for this board.

8.1.3 Erase Result

Enter the board number. If that particular board can be erased, the message “Board erased” will be
displayed. If it is not possible to erase the score, the TD menu will be displayed again after you have
pressed OK. Players then re-enter data for board.

8.1.4 Retrieve Current Status

The expected table and Section of the Bridge mate will be displayed first. Press OK again to view the
current round of the Bridgemate and the corresponding pairs at the table. You will also see the boards
played in this round.

8.1.5 Overview of Missing Scores

The Bridgemate will display the numbers of the boards not yet entered in this round.

8.1.6 Resetting the Bridgemate

The Bridgemate can be reset from the TD menu. It will now return to the main screen.
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9.1 No Display Visible on Bridgemate screen

Press OK to “wake-up” the bridgemate.

Check battery compartment at rear of bridgemate-

Replace any missing batteries

Check batteries are fitted with correct polarity

Check that the flat end of the battery is making contact with the spring. (Careless insertion of the
battery can result in the spring being pushed underneath the battery.)

Press the + key on the bridgemate repeatedly (this will increase the contrast) — may take some time!!
Check batteries if you have a battery tester and replace “dead” batteries; else replace all the batteries.
If you do replace battery/batteries you may find that the display is too dark to read. Press - key on the
front of the bridgemate repeatedly. This will decrease the contrast — may take a very long time!!

9.2 Display Contrast Incorrect (too faint or dark)

Most likely cause is incorrect contrast setting
If bridgemate is not in use, press + key repeatedly
If bridgemate is in use, insert TD key and press + key repeatedly

9.3 System Not Activated

You will need to Add the Table in BCS. This can usually be done by restarting the Scorer and
Launching BS again.

9.4 Bridgemates have not been reset

For example, setting up for an event, you press the OK button on a bridgemate and find that you are
at the BOARD/CONTR screen. This can happen if you did not complete the previous movement
(perhaps because you did not have time to play the last round, or a final round score was never
entered). The movement is still stored in the Bridgemate Server and each Bridgemate.

To reset, Run BCS and reset the Bridgemate Server using Server / Reset. Alternatively, disconnect
mains supply to server, remove a battery from server (with no power, server loses any residual data),
then replace battery in server and reconnect to mains supply.

Now go to each Bridgemate and press OK.

If it says “Bridgemate Pro” and the firmware version number and language, then it has been reset.
If it says anything else, then it needs to be reset.

Press OK or Cancel until it says “Board / Contr”.

Insert the TD-Key and click 0 and OK. Take out the TD-Key. Now it is reset.

9.5 Replacing a Bridgemate during an Event

In BCS select Server >Show Tables

Choose relevant table and click “log off table(s)” = Are you sure? -> Yes - Report > Close - Close
Show Tables.

That bridgemate will now be logged off from the server.

Take another bridgemate, set (TD key) to correct section, table & channel, activate by pressing OK

9.6 Bridgemate Error Messages

BOARD ALREADY If this message appears, then the board number
PLAYED! Rx entered in the bridgemate during this round (x) has
already been scored.

TD key - Option 5 to see what boards have still to be scored at this table during this round. You will
probably find that a board the players think has been scored has not.
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TD key—-> Option 3 to erase the board. Players can then enter details for the board previously entered
with the wrong board number.

BOARD NUMBER If this message appears, then the board number
INCORRECT! Rx entered in the bridgemate is not due to be played at
this table during round (x).

Rx in the error message shows the round the bridgemate is on. If this value is one less than the
actual round, the most likely cause is that a board has not been scored during round x. Check with
TD key = Option 5 to see what boards have still to be scored for round x. Get players to enter any
missing scores and at the end of that, the message “End of Round” should appear. OK till get to next
round and board number that produced the error message should now be accepted.

If the value of x in the error message does not correspond to the actual round: -

TD key = Option 4 to check Bridgemate is set up for correct section/table and round information
(round number, boards, and NS & EW pair numbers). If Bridgemate has been set up incorrectly, TD
key = Option 0 (Reset) then remove TD key. OK to get initial bridgemate screen display, TD key 2>
enter correct section/table info.

If the section/table is correct but board numbers in this display do not match the boards on the table,
check that the boards have been moved correctly at the change of round and correct the boards
where required.

If the correct boards for the movement are on the table then the most likely explanation is that
the scorer has selected the wrong movement —inform scorer / Chief TD immediately.

If this message appears then the bridgemate has
lost communication with the server. May be trivial,
but [potentially serious!|]

Failed to send
game data, retry?

Press OK on bridgemate to re-send data
Move bridgemate close to server and try to re-send data.
Bridgemate may be faulty — follow the procedure 8.4 to replace the Bridgemate.

If the above fail to solve the problem —inform scorer/Chief TD immediately

Check: - Mains power

Battery level in server (remove mains power BMPro for battery level

Data in server (BCS - Server > Show tables). (This will show scores entered so far and alll

movement data)

Data in bws file (open bws file in Access and inspect tables)

If data in bws file appears OK: -
BCS - Session = Synchronise client <-> server = Recover tab - Recover and follow on-
screen prompts (this process deletes all the data in the server and replaces it with the data in
the bws file). If necessary, reset bridgemates (TD key = Option 0).

If data in bws file is corrupt or step 5 fails to solve the problem, issue paper travellers
and instruct players to enter score for all boards from the start of current round.

9.7 No “End of Round” or “End of session” message

The likely reason for this is an unscored board(s) in this round.
Try TD key = Option 5 to see what boards have still to be scored at this table during this round. You
will probably find that a board the players think has been scored has not.

If, when the player first turns on the Bridgemate, it seems to bypass the initial player number entry
screen and immediately asks for a Board Number, it is possible that the previous session wasn’t
completed. Either use the TD key to reset the Bridgemate (option 0 with the TD key inserted), or ask
affected players to simply enter an illogical board number e.g. 59 and this will force the system to re-
synchronise with the current movement in the Bridgemate server. In both these cases, the Bridgemate
should then offer the initial screen asking for their player numbers. If not, simply continue playing (their
names will come through to Scorer as “Unknown”) and enter their names manually later. If you enter
the illogical board number and it doesn't reset, it's possible that the player pressed the OK button right
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through the Player Number screens without looking. In this case, the scoring side will work fine but
their names and numbers will appear as "Unknown" and they will need to be corrected later.
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10.1 Server cannot be connected

If BCS reports "Not Connected" check the following:-

All cables set correctly & correct voltage

Does the Bridgemate Server have a green light?

Is the Bridgemate Server physically connected to the PC?

If a USB to serial converter cable is being used, check that the driver for the cable is loaded. To do
this, use Start / Control Panel / System / Hardware / Device Manager /Ports / right-mouse the relevant
port and select Properties / Port Setting / Advanced. The port number must be in the range com1 to
com10.

If the driver is missing, you can re-load it using the CD that came with the USB to serial converter
cable. If the port number is com11 or above, you can change it using Port Setting / Advanced.

10.2 Replacing a Server or Server loses all power

You should always have batteries in the Bridgemate server unit so that in the event of a power failure,
the process can continue with no data loss. However, if the Server does become disconnected from
power supply (mains & battery), all data it contained will be lost & the Bridgemates will not function. If
you tenter a score in a Bridgemate the message "Failure to send data; retry?" will appear. The
situation can be rectified by the procedure in Section 6.1
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11.1 Computer Freezes During an event

The biggest problem when a Computer freezes is that it cannot be closed down using any of the
normal Windows methods (File > Exit, Alt+F4 etc). To get round this Press Ctrl + Alt + Del. This will
bring up the Windows Task Manager. Select the program (often there will be a note beside it saying
that it is not responding) and click on End Task. The program should then close down. If the
Windows Task Manager cannot be invoked, then you should close down the computer by holding the
power key/button down for 5-10 seconds. You will need to restart the Scorer from scratch but
remember not to overwrite the Database.

11.2 Computer Closes Down During an event

A common cause is the Laptop has gone into Standby (hibernate mode) after no key has been
pressed for a certain time. It is best at start to set the Power Options in Control Panel to avoid this.
However, as long as the Bridgemate Server retains power (mains or battery) it will retain all the data it
had before the crash as well as any results sent from the Bridgemates while the computer was down.
You will need to restart the Scorer from scratch but remember not to overwrite the Database.

END OF DOCUMENT
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